# Records Training Manual

## Banner General Overview
- Terminology
- Form name explanation for Student and Accounts Receivables
- Shortcuts
- How to perform queries

## SIS Screen/Banner form

## FERPA – Confidentiality Statement

## Querying Person Information
- **SOAIHEN** – Person Search Form
- **SOACOMP** – Non-Person Search Form
- **GUIALT** – SSN/SIN Alternate ID Search Form
- Performing searches from the Key block

## SPAIHEN – Person Identification Form (FOAIHEN or PPAIHEN)
- Current Identification:
- Alternate Identification:
- Address: (TUIADDR or PPIADDR)
- Telephone: (SPATELE or PPATELE)
- Biographical: (SPAPERS)
- Email: (GOAEMAL)
- Emergency Contact information: SPAEMRG
- Additional Identification:

## Query Student Holds
- **SOAHOLD** – Hold Information
- **SOQHOLD** – Holds Query-Only

## Adding or Clearing Student Holds
- **SOAHOLD** – Hold Information

## Adding or Querying Comments
- **SPACMNT** – Person Comment
- **RHACOMM** – Financial Aid Comments

## Adding or Changing Advisors
- **SGAADVR** – Multiple Advisors

## Reviewing a Student's Registration Pin
- **SPAAPIN** – Alternate Personal Identification Number
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reviewing a Student’s Overrides</td>
<td>26</td>
</tr>
<tr>
<td>SFASRPO – Student Registration Permit-Override</td>
<td>26</td>
</tr>
<tr>
<td>Schedule Query Screens</td>
<td>27</td>
</tr>
<tr>
<td>SSASECQ – Schedule Section Query</td>
<td>27</td>
</tr>
<tr>
<td>SSAMATX – Building/Room Schedule Form</td>
<td>29</td>
</tr>
<tr>
<td>First Log in or Expired Password</td>
<td>30</td>
</tr>
<tr>
<td>Banner Navigation Shortcut Keys</td>
<td>32</td>
</tr>
</tbody>
</table>
Banner General Overview

Welcome to Banner, the NSU Records database. Banner is an integrated database and shares common elements (in particular Person related data) with all areas, allowing all areas to update or view those records as needed. The overall structure of Banner can be seen in the Menu Tree of the main menu. Banner has components for Student, Advancement and Alumni, Human Resources, Financial Aid, Finance, and General. Accounts Receivables is also a component but acts as a connection point for Financial Aid, Advancement, and Student and feeds all relevant information from these crucial business areas into Finance. The goal of this guide is to facilitate orientation training and be the first spot Banner users should look to regarding questions about what a form or field on a form is for. It is assumed that users have already participated in the Banner General Navigation training and this document builds from and assumes that the user is familiar with that information. A special “My Banner” folder has been constructed for first time Banner users to assist in the transition from SIS to the Records Database. You can request this layout from the Registrar’s Office.

Terminology

Keyblock: the portion at the top of a form that control what records are being displayed. To Navigate away from the key block, use the Next Block function. To return to the Key Block, use the Roll Back function.

Menu Bar: Located at the top of the window, the menu bar can be accessed either via mouse or by using Alt +X (where X represents the underlined alpha character of the Menu Bar). The most frequently utilized menus are Options (Alt +O) and Help (Alt + H). It is good to familiarize yourself with the options menu as it can change regularly depending on what form you are on and often which block of the form you are on. Some features are only available from the options menu. The options menu is also available by using the Right click button on the mouse.

Button Bar: The bar located directly below the Menu Bar, it houses the mouse shortcut buttons.

Effective Term: Banner Student frequently uses Effective term logic to designate when a record was initially generated and for how long that record remained in place. Forms that have effective term logic will almost always contain a Maintenance Button which will allow you to either Copy the existing records forward to the keyblock term value, or End the records as of the keyblock term value.

Go To: the Go To box is used to access a new form. It is available at the Main Menu but is also available from any form using the Direct Access function (F5). Repeating the Direct Access function will dismiss the GoTo window. The Go To box is supported by a search form (GUIOBJJS) available from the Search Button.

Search Button: Many fields in Banner are validated via a validation table (though some are validated via rule forms or records from other forms). A validated field will have the Search Button to the right of the field. Most often, using the Search or List of Values function (F9) will pull up the source of the validation. If multiple sources are possible frequently a second function (often CQuery or Count Query Hits or Shift +F2) will pull up the other options. If multiple options exist, clicking the Search Button will pull up a window with the different options available.

Hint Line: Located at the bottom of the screen (you may need to maximize your window to see it), the Hint lines provides “hints” and often also displays error messages. The hint line will always try to tell you where your cursor is currently located and will often give a brief description of the use of the current field or suggestions for short cut strokes. Always reference the hint line after saving to ensure the save was successful.

Supplemental Data Fields:
You can tell if a form or block is enabled with Supplemental data by observing the displayed status of the Button Bar icon. Just to the left of the Exit button is a light bulb icon. If the light bulb is “off” like so, then there supplemental data is not possible for this form or block. If the light bulb is colored, like so, then the
are supplemental data fields available but no records exist in those fields. If the light bulb is illuminated like so, ✨ then data does exist for that record.

You can access that data by using the light bulb icon (or Ctrl + D).

**Form name explanation for Student and Accounts Receivables:**
Student is divided into 11 areas, Catalog, Schedule, Person, Faculty, Location Management, Recruitment, Admissions, General Student, Registration, Academic History, and Degree Evaluations (known as Curriculum Advising and Program Planning, often referred to as CAPP). The first character of all Student forms begins with S. The second character of the name predominantly represents what sub-division (easily seen in the Menu tree) the form belongs to. There are 676 forms in Student in total:

- A for Admissions 28
- C for Catalog 11
- E for Service 10
- F for Fee Assessment/Registration 45
- G for General Student 16
- H for Academic History 73
- I for Instructor/Faculty 18
- L for Location Management (Housing) 31
- M for Compliance (Degree Audits) 32
- O for Overall, shared across areas 73
- P for Person 7
- R for Recruiting 14
- S for Schedule 29
- T for Validation Table 288
- U for Utility 1

Accounts Receivables is divided into 3 areas, Student, Finance, and General (which is used by both Student and Finance). Many Student forms have Finance versions of them. In general, Finance versions of the form do not involve Term codes while just about all student forms do. Consequently the name of each form follows this convention. The first character of all AR forms is a T which stands for T Accounting or Transaction. The second character of the form name represents which area it belongs to. There are 98 forms in Accounts Receivables in total.

- F for Finance 15 forms
- G for General 18 forms
- O for Overall 3 forms
- S for Student 42 forms
- T for validation tables 16 forms
- U for Utility 1 form
- V for Title IV 3 forms

Not all forms will be covered in this guide. We will mostly be covering the Student AR forms.

**Shortcuts**
Key stroke shortcuts are highly recommended for Banner users especially those utilizing data entry. If you are entering amounts into a field with decimals but the value you are entering does not need decimals, you can just enter the integer values and Banner will provide the decimal structure for you.

There are shortcuts for checking and unchecking boxes (spacebar) and accessing the menus (Alt + O expands the Options Menu). Review the final page of the guide for a shortcut guide.

**How to perform queries**
Queries can be performed on almost every form in Banner. If you only wanted to see all transactions from a specific term you could pull up that account, enter query mode, populate the term value, and then execute the query to get your results. Many AR forms even have a query balance field to facilitate such queries. Shortcuts for queries are:

- Enter Query mode = F7
- Recall last query Criteria = F7 twice (i.e. F7, F7)
- Execute Query = F8
- Count of Query results = Shift + F2
- Exit Query mode = Ctrl Q (some forms start in query mode automatically, to exit these forms you’ll use Ctrl Q twice, once to exit query mode, and a second time to exit the form.)

When performing queries, the percent sign, %, is a wild card represent any character, and any number of characters. You are also able to use the underscore _ as a wild sign to represent any single character value.
## SIS Screen/Banner form

<table>
<thead>
<tr>
<th>Screen</th>
<th>Records/Banner</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>002</td>
<td>SOAIDEN</td>
<td>Name Search</td>
</tr>
<tr>
<td>003</td>
<td>SPAIDEN</td>
<td>Addresses</td>
</tr>
<tr>
<td>007</td>
<td>SPAIDEN</td>
<td>Biographical &amp; Demographical Information</td>
</tr>
<tr>
<td>010</td>
<td>SPAIDEN</td>
<td>E-Mail Addresses</td>
</tr>
<tr>
<td>011</td>
<td>SPAIDEN</td>
<td>Information Release Restrictions</td>
</tr>
<tr>
<td>012</td>
<td>SPAIDEN</td>
<td>SS# &amp; CWID</td>
</tr>
<tr>
<td>015</td>
<td>SPAIDEN</td>
<td>Next of Kin Addresses</td>
</tr>
<tr>
<td>017</td>
<td>SPAIDEN</td>
<td>Emergency Contacts</td>
</tr>
<tr>
<td>020</td>
<td>SPAIDEN</td>
<td>Phone Numbers</td>
</tr>
<tr>
<td>08T</td>
<td>SGASADD</td>
<td>Extract/Tracking for Reports</td>
</tr>
<tr>
<td>08T</td>
<td>SHICMBQ</td>
<td>Extract/Tracking for Reports</td>
</tr>
<tr>
<td>104</td>
<td>SFAREGS</td>
<td>Registration (No Access in Records)</td>
</tr>
<tr>
<td>184</td>
<td>SFASRPO</td>
<td>Registration</td>
</tr>
<tr>
<td>105</td>
<td>SSASECQ</td>
<td>Course Section Scan</td>
</tr>
<tr>
<td>107</td>
<td>SFASLST</td>
<td>Class List</td>
</tr>
<tr>
<td>109</td>
<td>SFAREGQ</td>
<td>Student Schedule</td>
</tr>
<tr>
<td>110</td>
<td>SGASTDQ</td>
<td>Academic Program Maintenance (matriculations)</td>
</tr>
<tr>
<td>111</td>
<td>SGASADD</td>
<td>Student Term Attributes (Academic Programs)</td>
</tr>
<tr>
<td>117</td>
<td>SHADEGR</td>
<td>Graduation Checkout</td>
</tr>
<tr>
<td>118</td>
<td>SHATERM</td>
<td>Academic Statistics</td>
</tr>
<tr>
<td>119</td>
<td>SGAADV</td>
<td>Term Report Flags</td>
</tr>
<tr>
<td>119</td>
<td>SGASPRT</td>
<td>Term Report Flags</td>
</tr>
<tr>
<td>119</td>
<td>SGASADD</td>
<td>Term Report Flags</td>
</tr>
<tr>
<td>119</td>
<td>SGAUSDF</td>
<td>Term Report Flags</td>
</tr>
<tr>
<td>120</td>
<td>NSU Connect</td>
<td>Graphic Student Schedule</td>
</tr>
<tr>
<td>121</td>
<td>SGASTDQ</td>
<td>Academic Program Summary</td>
</tr>
<tr>
<td>123</td>
<td>SHADEGR</td>
<td>Degrees Awarded</td>
</tr>
<tr>
<td>124</td>
<td>SHATCMT</td>
<td>Transcript Text</td>
</tr>
<tr>
<td>125</td>
<td>SCACRSE</td>
<td>Course Inventory Maintenance</td>
</tr>
<tr>
<td>126</td>
<td>SSASECT</td>
<td>Course Subtitles</td>
</tr>
<tr>
<td>127</td>
<td>None</td>
<td>Summary Statistics (course)</td>
</tr>
<tr>
<td>128</td>
<td>SCASRCH</td>
<td>Course Inventory Scan</td>
</tr>
<tr>
<td>12S</td>
<td>SSASECQ</td>
<td>Course Section Inquiry</td>
</tr>
<tr>
<td>129</td>
<td>SSASECT</td>
<td>Course Section Maintenance</td>
</tr>
<tr>
<td>130</td>
<td>SSASECT</td>
<td>Course Section Meeting Schedule</td>
</tr>
<tr>
<td>131</td>
<td>SSARRES</td>
<td>Section Registration Controls</td>
</tr>
<tr>
<td>131</td>
<td>SSAPREQ</td>
<td>Section Registration Controls</td>
</tr>
<tr>
<td>136</td>
<td>SHATERM</td>
<td>Transcript Display (unofficial transcript)</td>
</tr>
<tr>
<td>137</td>
<td>SHACRSE</td>
<td>Grade Change Audit</td>
</tr>
<tr>
<td>139</td>
<td>SFASTCA</td>
<td>Registration Audit Trail</td>
</tr>
<tr>
<td>140</td>
<td>SHATATR</td>
<td>Equivalency Maintenance (transfer credit)</td>
</tr>
<tr>
<td>141</td>
<td>SHATAEQ</td>
<td>Transfer Credit Maintenance</td>
</tr>
<tr>
<td>142</td>
<td>SHATRNS</td>
<td>Transfer Credit Articulation</td>
</tr>
<tr>
<td>143</td>
<td>SHATERM</td>
<td>Transfer Credit Awarded</td>
</tr>
<tr>
<td>Code</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>-------</td>
<td>-------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>144</td>
<td>SHATERM  Transfer Credit Summary</td>
<td></td>
</tr>
<tr>
<td>148</td>
<td>SOAHO LD  Registration Holds</td>
<td></td>
</tr>
<tr>
<td>148</td>
<td>SPACMNT  Registration Holds Comments</td>
<td></td>
</tr>
<tr>
<td>221</td>
<td>SOATEST  Test Score Information</td>
<td></td>
</tr>
<tr>
<td>409</td>
<td>TSICSRV  Account Snapshot</td>
<td></td>
</tr>
<tr>
<td>1E1</td>
<td>SFARQST  Enrollment Certification Summary</td>
<td></td>
</tr>
<tr>
<td>1E2</td>
<td>SFARQST  Enrollment Certification Request</td>
<td></td>
</tr>
<tr>
<td>1E3</td>
<td>SFARQSS  Enrollment Certification Request Log</td>
<td></td>
</tr>
<tr>
<td>1F4</td>
<td>SIAASGN  Faculty Non-Teaching Activities</td>
<td></td>
</tr>
<tr>
<td>1F5</td>
<td>SIAASGQ  Faculty Teaching Schedule</td>
<td></td>
</tr>
<tr>
<td>1G7</td>
<td>SFASLST  Grade Verification Roster</td>
<td></td>
</tr>
<tr>
<td>1T2</td>
<td>SHARQSS  Transcript Request Log</td>
<td></td>
</tr>
<tr>
<td>1T3</td>
<td>SHARQTC  Transcript Request Maintenance</td>
<td></td>
</tr>
<tr>
<td>606</td>
<td>SMIPROG  Degree Index List (all academic programs)</td>
<td></td>
</tr>
<tr>
<td>625</td>
<td>NSU Connect Degree Requirement Display</td>
<td></td>
</tr>
<tr>
<td>651</td>
<td>NSU Connect Student Degree Plan Definition</td>
<td></td>
</tr>
<tr>
<td>654</td>
<td>SMASADG  Course Exceptions (substitutions) (Not yet enabled in Records)</td>
<td></td>
</tr>
<tr>
<td>656</td>
<td>None       Advisor Notations (Part of Degree Works)</td>
<td></td>
</tr>
<tr>
<td>657</td>
<td>SHANCRS  Graduate Tracking</td>
<td></td>
</tr>
<tr>
<td>PF7</td>
<td>SHAQPNO  Thesis Title</td>
<td></td>
</tr>
<tr>
<td>681</td>
<td>NSU Connect Student Degree Audit Request</td>
<td></td>
</tr>
<tr>
<td>682</td>
<td>NSU Connect Academic Requirement Audit Request</td>
<td></td>
</tr>
<tr>
<td>GRD</td>
<td>SHATERM  Grade Display (course)</td>
<td></td>
</tr>
<tr>
<td>SP1</td>
<td>None       SPE Academic Maintenance (grades &amp; other academic information)</td>
<td></td>
</tr>
<tr>
<td>SP3</td>
<td>None       SPE Midterm Academic Maintenance (midterm grades)</td>
<td></td>
</tr>
</tbody>
</table>
FERPA – Confidentiality Statement

(Please Read)

Along with the right to access the transcripts of students at Northwestern State University comes the responsibility to maintain the rights of students, particularly as outlined in the Family Educational Rights and Privacy Act (FERPA). The University Catalog, Semester Bulletins and Student Handbook state the policy regarding student records at Northwestern State University. Student records are open to members of the faculty and staff who have a legitimate need to know their contents; however, you do have a responsibility to maintain confidentiality. Under the terms of FERPA, Northwestern State University has established the following as Directory Information: student’s name, mailing address, email address, photograph, telephone number, dates of attendance, enrollment status (e.g., undergraduate or graduate; full-time or part-time), major field of study, participation in officially recognized activities and sports, weight and height of members of athletic teams, degrees, honors and awards received, including naming to honor rolls; and the most recent education agency or institution attended. All other information may not be released without written consent of the student. Grades, Social Security Numbers, Campus Wide ID Numbers, Financial Information, Ethnic, Religious Information, and Student Schedules should not be released to anyone other than the student under discussion and not over the phone.
Querying Person Information

There are several forms that can be used to find an ID in Banner as well as the ability to perform searches from the key block of any form with ID fields. Most of these features should have been part of your general overview training. They are included here for review and completeness.

The primary form which stores information about the ID is SPAIDEN which is also reviewed here as well.

If the key block has an ID field (like SPAIDEN depicted below), you can immediately access three query screens to assist you in finding an ID record by using the mouse to click the Search icon next to the ID field.

Doing so will pull up the Options List window. It’s also possible to access using shortcuts as described in the hint line at the bottom of the form. It’s also possible to access the Generate ID screen using a shortcut.

The three search screens are reviewed below. If your responsibilities will require you to use the Generate ID functionality, you will receive separate training for that form.

On some forms the shortcut is different, so it always helps to review the Hint Line description.

<table>
<thead>
<tr>
<th>Option</th>
<th>Form</th>
<th>Shortcut</th>
<th>Hint Line Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Person Search</td>
<td>SOAIDEN</td>
<td>F9</td>
<td>LIST, LOV</td>
</tr>
<tr>
<td>Non-Person Search</td>
<td>SOACOMP</td>
<td>Shift + F2</td>
<td>COUNT HITS, COUNT</td>
</tr>
<tr>
<td>Alternate ID Search</td>
<td>GUIALT1</td>
<td>F4</td>
<td>DUPLICATE RECORD</td>
</tr>
<tr>
<td>Generate ID button</td>
<td>GOAMTCH</td>
<td>F3</td>
<td>DUP ITEM</td>
</tr>
</tbody>
</table>
SOAIDEN – Person Search Form

Purpose
This form can be accessed directly or from any Keyblock ID field by using the List of Value function (F9). It is used to search for person records.

This form starts in query mode. Simply enter your query values and execute the query (F8). If you accidentally accessed this form you will need to use the exit function (Ctrl + Q) twice, first to exit the query, and then again to exit the form.

You can use the “%” and “_” as wildcards.

Note that when a query is performed, only records that match those criteria exactly are displayed. You can identify if the record displayed is the “current” identification of that ID by looking at the Change Indicator column. If the field is null, then it is the current Identification. If it is populated with an “I”, it means it’s the record of an ID number change. If populated with an N, then it is the record of a name change.

Once you’ve found the record you are seeking, you can highlight that record and double click on the id or use the select function (Shift + F3) to pull the ID back into your keyblock ID field.
SOACOMP – Non-Person Search Form

Purpose
This form can be accessed directly or from any Keyblock ID field by using the Count Query Hits function (Shift + F2). It is used to search for non-person or company records.

This form starts in query mode. Simply enter your query values and execute the query (F8). If you accidentally accessed this form you will need to use the exit function (Ctrl + Q) twice, first to exit the query, and then again to exit the form.

You can use the “%” and “_” as wildcards. It will only display non-person records.
GUIALTI – SSN/SIN Alternate ID Search Form

Purpose
This form can be accessed directly or from any Keyblock ID field by using the Duplicate Record function (F4) or sometimes Duplicate Item (F3). It’s best to review the hint line text to determine which stroke to use. It is used to search for both person and non-person records. It’s greatest advantages over the other two forms reviewed above are that you can search by SSN or also by Entity code.

This form starts in query mode. Simply enter your query values and execute the query (F8). If you accidentally accessed this form you will need to use the exit function (Ctrl + Q) twice, first to exit the query, and then again to exit the form.

You can use the “%” and “_” as wildcards.

Because this form includes SSN, Birthdate, and Name information, should you have security access to it, you must be extra careful to never take print shot of results or leave results up on your screen, especially if you step away from your computer.
Performing searches from the Key block

Purpose
If you know the name of the ID you are looking for, or at least part of the name, you can also perform queries directly from the Banner form if it has ID and name fields on the block (keyblock or information block).

ID: Potter, H%

After entering your name information, if you use tab or enter, Banner will start a search for that query. If it only finds one record, it will populate the ID in the ID field and you'll be able to continue through to the information blocks.

However, if it finds multiple records, you'll get the ID and Name Extended Search window.

The count field will tell you how many records it found, in this case, 6. If you expand the results field (use Alt + up or down arrows), you'll be able to see the records it found. Notice that some of the records are left justified and other are indented.

The left justified records are the Current ID records. Those that are indented are alternate records for the left justified ID above them. If you see the ID you are looking for you can highlight it and hit enter to populate it into the keyblock. It doesn’t matter if you select the current ID or not, the current ID will populate the keyblock.
If there are too many records to review, you can further reduce your search by entering additional known information and executing the query. In this scenario, I’m reducing my search by adding gender. I populate the gender value into the field and execute the query by using the magnifying icon, or F8.

This will reduce my query values making it easier to review the records. If there are still too many records, additional queries can be done. The query will only review active address records when performing searches.

Should your additional queries result in no matches, the count will reduce to 0 and the Results field will populate with “Default” and not be selectable. You can undo the last query by clearing the Reduce Search by field populated and re-executing.

You can either exit out of the window or you can select and ID and hit enter to be returned to the field with that ID number.
SPAIDEN – Person Identification Form (FOAIDEN or PPAIDEN)

Purpose
This is the primary form for maintaining contract information for an ID. Each module of Banner has its own variation of this form. It has 8 tabs. Some of the tabs also exist as stand-alone forms as well.

Current Identification:

This tab shows full detail of the name value which is displayed in name fields like those found in the keyblock. If any name changes are made, the user simply overwrites the existing values that need edits and saves. A history of saved changes is stored on the next tab, the alternate ID tab. The information on the far right is maintained by the system and it’s not possible to edit the data in the ID and Name Source fields.

Alternate Identification:

Changed ID or Name information is stored here. The user who performed the change is stored with the information. These records display differently if name searches are performed from the keyblock or other search forms. From the keyblock, these records are indented. On other search forms, the Change Indicator field is populated with an “I” for ID change or an “N” for Name change. Only records that are left justified or do not have a change value are Current ID records.
The Address tab stores address information. Any active and current address always sorts at the top of the list. An address is considered active based on two criteria: the Inactive Address box is unchecked or the To Date field is blank or has a date which has not yet arrived. Person IDs are only allowed one active address record for a given address type. A non-person record however can have multiple address records of the same address type (just think about how many Starbucks or McDonalds there are).

When an ID changes their address, the current record is NOT overwritten but date ended and a new record with the new address is started. This allows tracking address history. Students are able to change their address via NSU Connect.

Telephone values can be associated with an address if applicable.
Telephone: (SPATELE or PPATELE)

Telephone data is tracked on this tab and similar to address records, active and current telephone records sort to the top. A record is inactive if the inactive checkbox is checked. If a telephone record is associated with a residence, the Address Type and Sequence will be populated as displayed.

Biographical: (SPAPERS)

The Biographical tab stores personal information and demographics like birth date, and race or ethnicity. There is some enhanced security on this screen that masks the SSN value if you are not in the appropriate security group to see that information.

Email: (GOAEMAL)

Email and URL pages can be stored here. Note emails are inactivated using the checkbox.
**Emergency Contact information: SPAEMRG**
This form is also accessible independently as SPAEMRG. A student can declare multiple Emergency Contacts and these records are stored here with different Priority numbers. The student is able to alter these records over NSU Connect.

<table>
<thead>
<tr>
<th>Priority</th>
<th>Relationship</th>
<th>Telephone</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Area Code</td>
</tr>
</tbody>
</table>

- **Last Name:** Black
- **First Name:** Sirius
- **Middle Name:**
- **Address Type:**
- **Street Line 1:** 12 Grimmeuld Place
- **City:** London
- **State or Province:**
- **ZIP or Postal Code:**
- **Nation:** United Kingdom

### Additional Identification:
This tab is used to capture extra ID records typically for use with companion databases like the Library system or institution guest information.

<table>
<thead>
<tr>
<th>ID Type</th>
<th>Description</th>
<th>Additional Identification</th>
<th>Activity Date</th>
<th>User</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Query Student Holds

When working with student records, on many occasions you will encounter students that have holds. It’s important to understand how to review/read hold records.

SOAHOOK – Hold Information

Purpose

This form shows you all hold records on an ID. Holds that are active and still in effect will always sort to the top of the list. Within the active and inactive records, holds will sort alphabetically by hold code and then date. No hold record is ever going to be purged from an account so hold history will always be retained.

Hold Information

ID: 

Hold Details

Hold Type: Combined Reg - Trans Hold
Origination Code: 50

Hold Type: Transcript
Amount: From: 12-AUG-2011 To: 31-AUG-2011 Reason: This field only holds 30 char
Origination Code: 08

Hold Type: Registration Hold
Amount: From: 31-DEC-2009 To: 11-FEB-2009 Reason: This field displays online
Origination Code: 143

Keyblock

The ID field functions just as it does on every other form.

Hold Details

All data display for each record is visible online for the student to see except the Hold Type Code and the Origination Code. The descriptions of both are displayed instead of the code. The web page also shows what services the hold blocks.

• Hold Type (with description) – This code controls what services the hold blocks. You can review those blocks by looking at STVHLD and seeing what service are checked. The check means the account is blocked for those services.

• Reason – A free format field of 30 characters to add an optional short message to a hold. Highly recommended.

• Amount – This field will rarely be populated but is informational ONLY and allows for a dollar amount to be associated with a hold (overdue library book, un-returned sports equipment, etc) if desired. It is informational only and does not update any records on the account.

• From – this is the date the hold is first effective

• To – this is the date the hold is effective up until and not including. Use this field to determine if the hold is still in effect. If the “To” field has yet to pass, and the “From” field has yet to arrive, the hold is still active. If the date in the “To” field has already passed, the hold is no longer active.

• Origination (with description) – this field designates the Reason type and is a carry-over from SIS. The value must be populated as more refined security is in place and keys from this value. Users are only able to alter holds with the appropriate Origination Code number value.
SOQHOLD – Holds Query-Only

Purpose
As you've noticed, several Student and most AR forms have two Holds fields in the Keyblock.

If an ID has a hold that blocks processing, a Y will display in the first of these fields and the cursor will move to the second field. If you perform a search, F9, from this field it will access SOQHOLD.

It is not possible to directly navigate to this form (this is true of any form with a Q in the third position). The main difference between SOQHOLD and SOAHOLD, is that SOAHOLD shows all holds records (active and inactive) while SOQHOLD only shows records that are active and relevant to the form from which it was called.

As holds can block any number of processes, if SOQHOLD is opened from a different calling form, it may show different records than if access from an Accounts Receivables form. Just keep in mind that SOAHOLD is the true repository of hold records.
Adding or Clearing Student Holds

While all users will be able to view holds records, only a few users will be able to add or release holds. Most holds will be placed by batch processes due to an accounts overdue balance. These holds will also be cleared in batch as accounts are paid off and should require little manual intervention.

SOAHOLD – Hold Information

Purpose

The steps to add a hold are lengthier than the steps to clear a hold. At no time should a user edit holds that are outside of their jurisdiction.

Hold Information: SOAHOLD 3.2 (INTG8)

ID: 

Hold Details

Hold Type: [ ] Combined Reg - Trans Hold [ ] Original

Reason: [ ] You must populate Orig Code

Amount: From: 30-AUG-2011 To: 31-DEC-2099

Origination Code: 50

When students are reviewing their accounts online they will be able to see all values displayed on this form except for the hold code itself or the origination code. Both descriptions will be displayed instead. Web users will also see what processes are impacted by the hold based on the checkboxes of the code on STVHLDD.

Procedure: Placing a Hold:

1. Access SOAHOLD
2. Populate the key block with the student needing the hold reviewed or updated
3. Next Block (Ctrl + Pg Dwn)
4. Insert a record (F6) if any records already exist, if not, just proceed to the next step.
5. Enter the appropriate Hold code – You can select from a list of values (F9)
6. Enter a reason (max 30 char) to further explain the purpose of the hold (optional but best practice)
7. Adjust the dates if necessary
   a. The From date will default to today’s date and may be edited
   b. The To date will default to 31-DEC-2099 and may be edited
8. Enter the Origination value – You can select from a list of values (F9)
9. Save (F10) – Ensure the hint line says “Transaction Complete”

Procedure: Clearing a Hold:

1. Access SOAHOLD
2. Populate the key block with the account who’s hold is to be cleared
3. Next Block (Ctrl + Pg Dwn)
4. Find the hold to be cleared (you can use Arrow up or down keys, or Page up/down to scroll)
5. Once on the correct record, update the "To" date field with the current date. This is most effectively achieved by ensuring the To date value is highlighted and then type “T” and use tab.
6. Save (F10) – Ensure the hint line says “Transaction Complete”
Adding or Querying Comments

When using paper files, it is easy to add sticky notes, or messages to the file by simply tacking on a piece of paper. With electronic records, these notes are stored as comments in the system. It is very helpful to be able to find these comments especially when reviewing a student. Often lengthier comments are needed to explain certain holds as well. Any legacy comments from SIS 148 have been converted to the SPACMNT form.

SPACMNT – Person Comment

Purpose
This form is used to store comments about the student by various Student Service offices. Northwestern is using this to store comments from Recruiting, Admissions, Advising, and also conversion. It will be helpful to review these comments when researching a student’s record.

It is very unlikely that an AR user would ever need to store comments here since they should be using TGACOMC for that instead. Financial Aid also has their own comment screen, RHACOMM.

If you are attempting to add a comment related to a hold record, use the same Hold Type value for Comment Type and the same Originator value as the hold record. Also use the Contact value “HLD”.

Procedure:
1. Access SPACMNT
2. Populate the ID of the student needing comments in the Keyblock
3. Next Block (Ctrl + Pg Dwn)
4. Insert a record (F6) if any records already exist, if not, just proceed to the next step.
5. Populate the Comment Type (if the comment is related to a hold record, use the same value as the Hold type
6. Populate the Originator (if the comment is related to a hold record, use the same value as the Originator code from the hold)
7. Populate the Contact type if applicable (for Hold Comments, use HLD)
8. Tab to the Comment Text field
9. Enter comment – you can paste text here using the keystroke (ctrl+v)
10. Save (F10). This will populate each comment originator with the originator value entered above.

**RHACOMM – Financial Aid Comments**

**Purpose**
This form is the comment form used by Financial Aid. Should students have questions about their financial aid, you should naturally refer them to the Financial Aid office but you may be able to answer some of their questions by reviewing this comment form first.

Only Financial Aid users will have access to insert or update these records.

<table>
<thead>
<tr>
<th>ID:</th>
<th></th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Aid Year</th>
<th>Category Code</th>
<th>Created</th>
<th>Activity Date</th>
<th>User</th>
</tr>
</thead>
<tbody>
<tr>
<td>09/10</td>
<td></td>
<td>18-NOV-2010</td>
<td>18-NOV-2010</td>
<td>TRIBE</td>
</tr>
<tr>
<td></td>
<td>STUDENT PACKAGED /DA</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Aid Year</th>
<th>Category Code</th>
<th>Created</th>
<th>Activity Date</th>
<th>User</th>
</tr>
</thead>
<tbody>
<tr>
<td>09/10</td>
<td></td>
<td>18-NOV-2010</td>
<td>18-NOV-2010</td>
<td>REBING</td>
</tr>
<tr>
<td></td>
<td>NO DORM DEP /40-1000</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Adding or Changing Advisors

Students being students, they will change their majors often. Consequently, they change advisors often too. Keeping clean advisor lists is extremely beneficial to Faculty and Advisors and simplifies their access via NSU Connect.

SGAADVR – Multiple Advisors

Purpose
This form is used to maintain a student’s advisor. A student is able to have multiple advisors but at least one, and only one, can be designated as the primary advisor. Advisor records are stored using “Term Effective” logic. Consequently, a user must PAY ATTENTION to the value of all three term code fields on the form.

- The Keyblock term code should always represent the term during which the change to advisors is desired
- The From Term code represents the term the displayed records started.
  - If the From Term value does not match the Keyblock Term value, the Maintenance button will be active
  - If the From Term value is equal to the Keyblock Term, the Maintenance button will be unavailable
- The To Term code represents to what point the displayed record is active.
  - If the To Term is 999999, the record is openly effective
  - If the To Term is less than 999999, then a term effective record begins with that To Term value. You may need to perform a second update in that effective record as well should you be making a change in the current term.

Procedure:
1. Access SGAADVR
2. Populate the ID of the student needing an Advisor update in the Keyblock
3. Populate the Keyblock Term in which the change should occur
4. Next Block (Ctrl + Pg Dwn)
5. Review the Record to determine the next step:
   a. If there are no records, the From Term should match the Keyblock Term – Proceed to step 8
   b. If there are records but the From Term matches the Keyblock Term – Proceed to step 7
   c. If the From Term is different than the Keyblock, - Proceed to the next step
6. Use the Maintenance Button – a window will ask if you wish to Copy Advisor or End Advisor
a. Copy Advisor will copy forward any existing records and will be the most commonly used option
   i. The Record Duplicate function (F4) can be performed without having to use the Maintenance Button
   ii. When Copy Advisor is used, the From Term box is updated to the Keyblock Term.
   iii. Proceed to step 7
b. End Advisor should only be used to close out all existing Advisor records and not replace them with a different advisor. If you wish to replace an Advisor, use Copy and follow the 6a steps.
   i. The Field Duplicate function (F3) can be performed without having to use the Maintenance Button
   ii. When End Advisor is used, the To Term will now match the Keyblock Term.
   iii. Save (F10) and Rollback (Shift F7). The record has been successfully ended

7. Whether adding an additional instructor, or replacing the current, use Record Insert (F6) to create a blank row.
8. Enter the advisor ID or, if unknown, tab and enter the advisor name as if performing a name search (aka first enter Last Name followed by a comma and space, then First Name). Remember to use the % wild card if you are unsure how to spell the advisors name. Use tab to get the ID or resolve the ID search window. You can also use the Search icon (F9) to pull up the Faculty/Advisor Query form SIAIQRY. Once an ID is found, continue.
9. Save (F10). If you only needed to add an additional advisor, skip to step 13.
10. If you need to replace the existing advisor, review to see if the advisor to be removed is the Primary advisor. If so, transfer the primary checkbox to an advisor who is remaining with the student
    a. If the primary advisor needed to be swapped, Save (F10)
11. Now remove the older advisor using Record Remove (Shift F6)
12. Save (F10)
13. Review the To Term and ensure that it extends to 999999.
    a. If it does, you are finished. Rollback (Shift F7)
    b. If it does not, you will need to perform the same edit in that effective term record as well. Rollback (Shift F7) and update the Keyblock term to the value that had been displayed in the To term. Next block (Ctrl + Pg Dwn) and repeat starting at step 7.
Reviewing a Student’s Registration Pin

If a student is required to receive advising, the advisor will need to deliver an “Alternate PIN” to the student after advising has been delivered. Advisors will only have access to the student’s Alternate Pin, if the student is on their advising list.

SPAAPIN – Alternate Personal Identification Number

Purpose
This form is used to store the Registration PIN to be released to students after advising has been received.

<table>
<thead>
<tr>
<th>Term Code</th>
<th>Process Name</th>
<th>Alternate PIN</th>
<th>Activity Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>201301</td>
<td>TREG</td>
<td>20130</td>
<td>10-HA2-2012</td>
</tr>
</tbody>
</table>

Procedure:
1. Access SPAAPIN
2. Populate the ID of the student needing requesting the PIN in the Keyblock. PINs should only be released to a student with permission from an advisor.
3. Populate the Term code of pre-registration
4. Next Block (Ctrl + Pg Down)
5. You may use Rollback (Shift F7) to change to a different ID or Exit (Ctrl +Q) to leave the form.
Reviewing a Student’s Overrides
Any Registration Override Permissions granted by faculty are stored in the system. Overrides can also be granted via the database.

SFASRPO – Student Registration Permit-Override

Purpose
This form is used to view or edit Registration Overrides. In Banner, overrides are granted for a unique registration error. Just granting a student a capacity override, will not bypass a pre-requisite error message. Overrides can be CRN distinct (and should be for Capacity, Duplicate, Instructor Approval, Nursing, Rad Sci, and Time Permission). However, some overrides (like Pre-req) are best if designated in the database where they do not need to be CRN specific.

Some permissions are unique to a department. **The Nursing Permission value should NOT BE USED BY ANY FACULTY MEMBER, only by Nursing Department administrators with direct access to the Records database.**

Time Conflict should only be granted by the instructor of the course in which the student is departing early.

Your ID is stored with these records so the institution can and will review overrides that were granted for trends or misuse.

**There is not an override for increasing the Max Hours a student may register for. Unlike SIS, this specific override will need to be handled by the Registrar's Office.**

Using the Search button over CRN, SUBJ, Course Number, or Section will pull up SSASECQ.
Schedule Query Screens
SSASECQ – Schedule Section Query

Purpose
Use the Schedule Section Query Form (SSASECQ) to display any or all sections currently in the system. The form is run in query-only mode, and no changes can be made to any fields. This is a stand alone query form, which may be accessed from the menu.

You can access this query form from many Student forms.

SSASECQ can be accessed in these ways:

- From the main menu by opening the Student Menu, opening the Class Schedule menu, then opening SSASECQ
- From SSASECT by clicking on the down-arrow next to the CRN field (F9) or by clicking on the down-arrow next to the Subject field (F9).
- From SSADETL, SSAPREQ, SSARRES, SSATEXT, SSAWSEC, SSAOVRR, SSAACCL, SSASYLB, and SSAXLSQ by clicking on the down-arrow next to the CRN field (Shift + F2)

Once you are in this form, use Execute Query (F8) to see all classes or you can query by entering values in any fields or combination of fields (Subject only, Subject and Course number, Part of Term, Section, etc). Greater than and less than signs can be used as well (<, >) especially in fields with enrollment information. Once you choose which option to search for, use Execute Query (F8) to see results. If you want to perform a second query, use Enter Query (F7). To perform the same query a second time, use Enter Query twice (F7 twice) to retrieve your same query parameters and then Execute Query (F8) to perform the query or Count Hits (Shift F2) to see in the hint line the number of results that would be received if Execute was performed. If your query was unsuccessful, you’ll need to use Quit (Ctrl Q) twice to exit the form.

Banner form

It is often helpful to extract this data into an Excel spreadsheet using the Help Menu: Data Extract feature. To successfully perform data extract on SSASECQ, follow these steps:

Procedure for Data Extract:
1. Access SSASECT
2. Blank out the Keyblock Term code value
3. Exit SSASECT (Ctrl+Q)
4. Access SSASECQ. The Term code field should be blank.
5. Enter your desired query parameters (populate the fields that correspond to what you are looking for)
6. Execute the Query (F8)
7. Open the Help Menu (Alt + H) and select Extract Data No Key (X)

8. If a new Web Browser window does not open, you may be encountering popup blocker, try the extract again and hold down the Ctrl key until the window opens. You may need to access your web browser and add the web address to your Safe directories.

9. Once the window opens, you should be prompted to Open or Save the output.
SSAMATX – Building/Room Schedule Form

The Building/Room Schedule Form (SSAMATX) is accessed from SSASECT Meeting Time block Options menu and displays information about what is scheduled in a specific building/room. You can query all scheduled buildings and rooms, or you can limit the query by entering selection criteria.

The information on this form is query-only. Before you execute a query, the form displays the Building and Room fields, the Days of the Week check boxes and Term, in the scroll box, and the Subject field.

- Enter a building and F8 to view all room schedules in a building.
- Enter a building and room number to view all classes in a specific room.
- Scroll the middle section and change term code to view building/room schedules in a different term than the default. NOTE: If Events are scheduled in Banner, the term code will display EVENT. It would be better to query by dates rather than Term code if events are put into Banner.

Banner form

The form queries for exactly the value you enter take extra care when using Date values for searches. I find that building, room and days of the week work best. Remember to use the wild card % to help with searches.

Procedure:

1. Access SSAMATX. The Term code field may or may not be blank.
2. Enter your desired query parameters (populate the fields that correspond to what you are looking for)
3. Execute the Query (F8)

It is also possible to perform data extract on this screen. You can access Data Extract from the Help Menu.
First Log in or Expired Password
If this is your first time logging in to the new Records system, you will need to get a Username and Password and security access approved by Mrs. Bell. Assuming you have that, you can access the Records database using the following steps:

1. Place the mouse pointer on Faculty & Staff within the Menu box.

2. Click on “Web for Faculty” to access the Web for Faculty or the NSUConnect system.

Note: The Attendance Reporting System, Moodle, NSUConnect Instructional Booklet, SIS Instructional Booklet for Advising & Registration, and the Family Educational Rights and Privacy Act Guidelines and Tutorial can
To Access Spring and Summer 2012 information, click on “Enter Faculty and Advisor Services” or “Midterm and Final Grades” for access to the Web for Faculty and Advisors System; or

To Access Fall 2012 information, click on NSUConnect for access to the SSB Banner System; or

To Access Fall 2012 Records Database, use the Records link.

The first time you log in, you password will automatically expire and you will need to pick a new password.

The Database pages display best if your monitor settings are at 1024 x 768 or something slightly larger than that. You can typically alter your monitor settings by right clicking on your desktop and selecting Display or Settings.

First time users are also Highly encouraged to access the File Menu: Preferences feature and ensure that all checkboxes are checked (“Display Form Name on Menu” and “Include Header Row” are typically unchecked).

There is a My Banner preset configuration which you can request from the Records office if you’re My Banner folder only contains “Organize My Banner”.

Northwestern State University Web for Faculty & Advisors Test System

SPRING 2012 CALENDAR FOR THE SUBMISSION OF GRADES

1. All final grades for the 1st 4 Week Session are due to be entered by 12:00 midnight on Tuesday, February 7, 2012.
2. Midterm grades are due to be entered by 12:00 midnight on Sunday, March 4, 2012. Note: Please do not enter midterm grades for the following: Graduate, Student Teaching, Field Experience, Co-op, Internship, Practicum, Aviation Science, Placement, and Special Examination courses. In addition, a grade of “Y” should not be entered for midterm grades.
3. All final grades for the 1st & 2nd 4 Week (A-Term) and 2nd 4 Week Sessions are due to be entered by 12:00 midnight on Tuesday, March 6, 2012.
Banner Navigation Shortcut Keys

There are numerous keyboard short cuts available in BANNER. The specific keystrokes for a function depend on your environment. The Show Keys command in the Help Menu lists the keyboard equivalents available in your environment for the current form, window and field. In addition, the Alt key gives quick access to the Menu Bar items.

**Menu Bar:**
- Alt+E: File
- Alt+B: Edit
- Alt+R: Options
- Alt+T: Block
- Alt+Q: Item
- Alt+H: Record
- Alt+B: Query
- Alt+T: Tools
- Alt+H: Help

**Toolbar (or Icon bar):**
- Rollback
- Insert Record
- Previous Record
- Previous Block
- Next Record
- Delete Record
- Next Block
- Execute Query
- Cancel Query
- Print
- Broadcast Message
- Multi-Institution Functionality
- Supplemental Data Engine
- Save
- Select
- Remove Record
- Block
- Query
- Banner Message
- BDMS
- Fine-Grained Access
- Online Help
- Exit

**Tips for Date fields:**
Enter any alpha character (ie “T”) for today’s date
Enter DD (between 01 and 31) and Banner will default the current Month and Year
Enter MMDD and Banner will default the current Year
Enter MMDDYY and Banner will default the full date
Below is a list of some of the more common shortcut keys used.

<table>
<thead>
<tr>
<th>Function</th>
<th>Shortcut Key</th>
<th>Function</th>
<th>Shortcut Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save</td>
<td>F10</td>
<td>Record Next</td>
<td>↓ or Page Dn</td>
</tr>
<tr>
<td>Rollback</td>
<td>Shift + F7</td>
<td>Record Previous</td>
<td>↑ or Page Up</td>
</tr>
<tr>
<td>Exit</td>
<td>Ctrl + Q</td>
<td>Record Insert</td>
<td>F6</td>
</tr>
<tr>
<td>List of Values</td>
<td>F9</td>
<td>Record Remove</td>
<td>Shift + F6</td>
</tr>
<tr>
<td>Block Next</td>
<td>Ctrl + Page Dn</td>
<td>Record Duplicate</td>
<td>F4</td>
</tr>
<tr>
<td>Block Previous</td>
<td>Ctrl + Page Up</td>
<td>Record Clear</td>
<td>Shift + F4</td>
</tr>
<tr>
<td>Block Clear</td>
<td>Shift + F5</td>
<td>Field Next</td>
<td>Tab</td>
</tr>
<tr>
<td>Query Enter</td>
<td>F7</td>
<td>Field Previous</td>
<td>Shift + Tab</td>
</tr>
<tr>
<td>Query Execute</td>
<td>F8</td>
<td>Field Clear</td>
<td>Ctrl + U</td>
</tr>
<tr>
<td>Query Cancel</td>
<td>Ctrl + Q</td>
<td>Field Duplicate</td>
<td>F3</td>
</tr>
<tr>
<td>Query Count Hits</td>
<td>Shift + F2</td>
<td>Cut</td>
<td>Ctrl + X</td>
</tr>
<tr>
<td>Query Last Criteria</td>
<td>F7, F7</td>
<td>Copy</td>
<td>Ctrl + C</td>
</tr>
<tr>
<td>Select Record</td>
<td>Shift + F3</td>
<td>Paste</td>
<td>Ctrl + V</td>
</tr>
<tr>
<td>Options Menu</td>
<td>Right Click</td>
<td>Edit</td>
<td>Ctrl + E</td>
</tr>
<tr>
<td>List Tab Pages</td>
<td>F2</td>
<td>Print Screen</td>
<td>Shift + F8</td>
</tr>
<tr>
<td>Direct Access bar</td>
<td>F5 (call or dismiss)</td>
<td>Display Error</td>
<td>Shift + F1</td>
</tr>
<tr>
<td>Check/uncheck box</td>
<td>Spacebar</td>
<td>Show Keys</td>
<td>Ctrl + F1</td>
</tr>
<tr>
<td>Select Radio values</td>
<td>← or →</td>
<td>Supplemental Data</td>
<td>Ctrl + D</td>
</tr>
<tr>
<td>GoTo: Review last</td>
<td>↑ or ↓</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>